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summary

This manual describes how to use the IwoPlan model. IwoPlan is a program in
Visual Basic that models growth and management of natural tropical forest. The
forest is represented as divided into many management units of variable size,
Each unit has growth modelled by simpie stand projection. The model uses GIS
files representing rivers and roads to develop a logical transport network. This is
extended by simulation to add forest roads and trails to extract timber or non-
timber forest products such as canes or oilseed. Management units are allocated
for harvesting based on their accessibility and cost of extracting products, as well
as constraints such as harvesting cycle. The model outputs include maps of
species distribution and product distribution, species stand tables, product
tables, yields over time for defined products, costs analysed by infrastructure
development, transport, and extraction and in-forest processing. Net revenues
are calculated, and discounted net worth at various interest rates.

Users can supply their own base maps of roads, rivers, management units and
forest types, species lists, stand tables by forest types, and growth models, to
effectively simulate any mixed tropical forest management project. Products,
costs and management units are also defined by the user. The interactive maps
allow selected areas to be protected from harvesting to create amenity areas,
buffer zones, etc.

The manual is divided into four parts. A Concepis section deals with the general
principles and assumptions of the model. A Crse studies section describes three
cases studies: Conventional timber production by mechanized logging, timber
production using chain-sawing at stump and manual or animal porterage of
boards, and production of canes and oilseed as examples of non-timber
products. A Menu reference section provides detailed user information on each
menu action and dialog form. A Configuration section provides technical
information for specialist users on installing the model and configuring it for
new projects or baseline data.
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IwoFlan is a computer package designed to assist in

planning the sustainable production of forest resources,

including both timber and non-timber plant products, It
What is IwoPlan? has been developed by Iwokrama primarily for its internal
use, but the model is suitable for general use in any
tropical forest situation where the necessary basic

information is available,

The model is designed to calculate yields, harvest schedules, costs, prices and net revenues given
information about the transport network (roads and rivers), forest types, species, growth rates,
products, processing and transport methods, and unit costs. It can take into account different
options for management to give various scenarios for managing the forest.

The outputs are in the form of maps, graphs and tables. These can be copied into other packages
such as MS Word or MS Excel for publication or inclusion in printed reports. The map formats
are also available as files that can be read by the ArcView GIS system.

This manual is for two kinds of IwoPlan user. The first are
Who is this manual for? those who want to use the model to discuss or review issues
of forest planning, or to develop forest management plans
for a specific project which has already been set up in the
model. Users at this level need to have a good knowledge of forest planning concepts, and some
familiarity with using common computer packages such as MS Excel, but they do not need
specialist knowledge of GIS or database techniques.

The second kind will be those users who set up or modify the configuration data for the model.
This includes the maps and forest inventory summaries used. This requires especially a
Knowledge of the ArcView GIS system, and also experience in manipulating forest inventory
data in either FoxPro or Excel, to generate the necessary stand table summary file. This manual
provides the necessary information to take such users through the configuration process.

The manual is divided into four main sections. The first,

How is the manual entitled Concepts, describes the key ideas and methods
structured? underlying the model.

The second, Case Studies, goes through the setting up and
running of model scenarios for three possible planning situations (conventional mechanised
logging, timber production with processing at stump, and production of canes and oilseed as
non-timber products).

The third section, Menu Reference, gives an explanation of all the program functions accessible
from the menu system in the form of a user’s reference guide.

The fourth section, Configuration, is for the more technical user, and explains how the GIS files
and inventory data is set up, and also explains how the various work files generated by the
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program as it runs can be used to import maps and results back into ArcView or Excel with a
high degree of detail. It also includes first-time installation of the program.

The background to the development of simple growth
Further reading models for use in Guyana is given by Alder (2000). The

models and volume functions in that report are those used
in the demonstration data provided with IwoPlax.

A short technical paper which summarises the use of IwoPlan is given by Alder et al. (2001).

General background to growth model design for natural forests will be found in Alder (1995).



Concepts

Models guide our actions in many aspects of life, not least
in the inner workings of the brain. They are able to do this
usefully, in spite of obvious deficiencies and
approximations they may contain, provided that we
constantly monitor the results of actions we take and revise
our planning process accordingly.

Models and reality

This process is illustrated in the diagram at the right. The model Plan
provides or informs a plan, upon which basis we act. Monitoring —»>

and evaluation of the results from the action allows us to perceive
deviations, and to adjust the model and the plan to give improved

actions.
Act
As an example, consider catching a cricket ball. The brain
does not compute with any accuracy the exact speed of the
ball, forces required in muscles, etc. It simply instructs us to :
move towards the ball. As we do so, the flight of the ball : Moni‘tc;;' g

and the body’s posture are monitored and adjusted and the process
updated, many times a second, until, hopefully, a perfect catch may
be achieved.

In forestry, the process is obviously much slower. Plans are Evaluate
typically formulated and updated over a 5-10 year cycle, but will be

adjusted more rapidly if circumstances change drastically, such as a forest fire,
collapse of an established market, etc. IwoPlan is one among many tools that can assist in
developing such plans. To be useful in this role, it does not need to be a perfect model. It only
needs to give suggestions that will lead us to take actions in approximately the right direction.
However, the model itself should (if it is used effectively) be continuously improved through the

rhonitoring and evaluation process.

This section discusses the concepts on which IwoPlan is based. Some of these involve great
simplifications of the real world. Through monitoring, we may establish whether these are
critical or not. We may for example, adjust the nature of the plant growth models, or decide to
alter the way the transport network is simulated or costs calculated. At the same time, in a future
cycle of application, we would use later and more current data, to maintain as close a
correspondence as possible between the actual situation, and the planning model that guides us.

IwoPlan divides all its calculations into 5-year periods.
Graphs and tables of yields and costs over time are per 5-
year period. The model projections can continue for several
hundred years if required, but the model will become
increasingly unrealistic over very long periods. Practically
speaking, for forest planning purposes, it is a good idea to use a 100-year time limit.

Time periods and time limit

This 5-year period is used in IwoPlan to reduce the number of calculations that the model needs
to carry out, so that it will give results fairly quickly (2-3 minutes on a 400 MHz computer). It
also simplifies and summarises the amount of tabulated output. It does however mean that
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IwoPlan cannot provide detailed information for year-by-year planning, It is essentially a tool for
long-term, strategic planning.

IwoPlan assumes that the forest is divided into a number of
distinct management units (MU). The MUs are known to
the model through a GIS shape file in which the MUs are
represented as polygons.

Management units

MUs can be any size, and can relate to physical features or be arbitrary. In Guyana it is common
to use 1 km square blocks (100 ha} as MUs in forest planning. Iwokrama (at least in the data
shown here) uses variable units based on stream watersheds, with sizes ranging typically from
300 to 2500 ha.

An important assumption of the model is that a whole MU will be completely harvested in any given 5-
year time period. An MU cannot be partiaily harvested in one period and completed in the next.
This means that the MUs must be small enough so that this gives reasonably realistic planning.
Very large MUs, or a great variation in MU size, will give rather ‘lumpy’ outputs from one period
to the next, because of the requirement that a whole MU is processed in one 5-year period.

As a guideline, the forest should be broken into at least 100 MUs, of as equal a size as possible.
The demonstration data provided with IwoPlan includes 405 MUs.

In IwoPlan, the forest must be described and mapped in
Forest types and stand tables terms of forest types. There can be any number of forest
types, and in a simple case there could be just one, covering
the whole planning area. Each forest type has to be
described by a stand table. This gives the species in each forest type, in terms of numbers of
stems per km?, by 10 cm diameter classes. The species do not need to be tree species: they could
be lianas, palms or other plants.

The Configuration section explains exactly how the forest type map and the stand table data are
input into the model.

When IwoPlan runs, the forest type map is overlaid with the management units map and used to
calculate a table which gives the area of each forest type within each management unit. This is
then applied to the stand table for the forest types to calculate an average stand table for each
management unit. ' '

One of IwoPlan’s main functions is to calculate the costs
and revenues from producing various products. In order to
do this, it must estimate the costs of transportation. This
involves components such as building roads and bridges,
making cataracts navigable, making and maintaining trails,
and then calculating distances along roads and trails to extract produce. To do this, there are a
number of aspects of the model concerned with transport network simulation.

The transport network




The processing base

IwoPlan assumes a single processing base for all products. This can be moved interactively
anywhere on the map, but there cannot be two bases, All marketing prices are calculated relative
to the base.

Streams and rivers

Streams and rivers are assumed to be potential transport routes. However, not all are equally
navigable. The GIS map layer that described the river and stream system must assign a value to
each section which indicates how easily it can be navigated by small or large boats. The
Configuration section explains how this is done,

TwoPlan reduces the navigability of rivers to three classes: none, small boats, or large boats. The
model understands that small boats can be used to extract non-timber plant products, but only
large boats can be used to extract timber in bulk or as logs. Log rafts are treated as being the
same as large boats for navigability assessment.

Roads

Roads fall into three categories. Permanent roads are described on a GIS map layer (see
Configuration section). These roads are not costed by IwoPlan for construction or general
maintenance, However, those sections which are actively used for timber transport do have a
maintenance charge calculated while they are in use.

Forest roads may be major or minor roads. Major roads are established by the model as they are
needed, and are assumed to join management unit centroidsl. These roads are actually mapped
as they are generated by the simulation, although their alignments should not be taken as
realistic. Minor roads are calculated to be of a certain length within each centroid, according to
the character of the logging operation, as described in Alder et al (2001}. Minor roads are
assumed to fall into disuse as soon as logging is completed, and are not maintained. Major roads
remain in use, and attract a maintenance charge, as long as the are en roufe to any active logging
area during any 5-year period.

In the model, major roads can, conditionally, cross streams or rivers. Whether they will do so
depends on the index for bridgeability assigned to each river or stream. Flow this should be set
up is described in detail in the Configuration section. If a bridge is needed, its cost is added to
that for constructing that particular segment of road.

Trails

The model only builds roads for mechanised logging of timber. For extraction of non-timber
products, it constructs trails. These involve an annual cost for as long as they remain in use, and
involve a different per km cost structure to roads. Trails are conceptually intended to be animal
transport or porterage routes, but the model is consistent enough to allow them to be regarded as
routes for mechanised vehicles such as tractors. Trails between MU centroids are maintained
according to the same rules as major roads, ie. so long as they are used in transit to another MU
that is actively being harvested. The length of trails within MUs, required for harvesting, are
calculated only according to a density factor and are not explicitly mapped. This employs the
same logic as for minor timber roads.

1 A centroid is the geometric centre of a polygon, equivalent to the centre of a circle.
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Transhipment and joining of routes

Transhipment occurs where one kind of transport route runs into another involving incompatible
transport system. It occurs between trails and roads, trails and streams, streams and roads.

For mechanised timber, a yarding and loading cost is charged each time transhipment occurs.
For NTPPs, if a trail runs to a road, then the goods are assumed to move by road from that point,
but there is no loading charge as such.

Some constraints are imposed in the model to prevent certain types of route connections. Roads
cannot develop from streams or trails, but must join to other roads, and ultimately the permanent
road network. In the present version, this logic does however prevent mechanical logging of
coupes accessible only by river, as the model does not allow the logicaily necessary major road
from the river to the MU centroid to be built. Whether this is a realistic constraint depends
substantially on the navigability of the river network to ferries able to carry trucks, bulldozers,
etc.

Management units are allocated as harvesting coupes for
timber or non-timber products according to a number of

Allocatlan of coupes logical criteria. Potential coupes must first of all satisfy the

following constraints:

O There must be some product available to harvest, after calculating the stock and allowing for
conservation criteria such as minimum stocking and percentage of retained stems.

O A period at least equivalent to the designated felling cycle for the product in question must
have elapsed since the MU was last harvested.

O The coupe must be on, or adjacent to another MU that is on, a transport route suitable for the
product in question.

Coupes satisfying these criteria are organised into a list, which is then prioritised according to
one of three possible options (selected via the Options menu). These sorting criteria may be:

Q Distance: MUs closest to the processing base by any possible route are given highest priority.
Q  Product density: MUs with the highest available ahrvest per/ha are given priority.

O Unit cost: MUs with the lowest unit cost of production are given priority. This is the most
complex option, as it involves evaluating how the transport network may be extended to
each coupe under consideration, and including road and bridge construction costs in the unit
cost for accessing that MU, as well as the incremental maintenance cost for the entire route
from the unit to the base. It also factors in product density, as MUs with higher product
density will tend to have lower unit costs.

Having prioritised coupes, they are then selected in sequence (from highest to lowest priority)
until the allowable cut constraint designated for a product is satisfied.

Products can be defined as being extracted according to two general methods, referred to as L-
type (logging) and N-type (NTPP). Only one coupe list is generated for all L-type products,
whereas the N-type products are harvested independently of each other. This respects the reality
that different types of timber species will be logged jointly, in a single operation; whereas NTPPs
such as liana, oilseed and palm leaf collection would be planned independently.



Individual species are represented in the model to the
Species and products extent that they are described and recognised in the stand
table data provided for each forest type, However,
managemment simulation is carried out at the level of
products. Products may be produced by one or more species. A single species could also
produce several products (such as Carapa guiananesis, which may produce both high-quality
timber and oil seed).

Products have the following properties assigned to them by the user as the model is set up, which
largely control how the simulation will proceed:

O They have conversion factors assigned, which may be relative to species volume, stem
numbers, or basal area, according to the users choice.

O They have management and conservation criteria, including harvesting cycle, numbers or
percentage of stems to be retained, minimum harvesting diameter, and allowable cut per
period (the aggregate amount of the product to be produced on the whole project in one 5-
year period).

O They have an associated technical extraction system. This is broadly L-type (logging, really
applicable solely to timber), or N-type (non-mechanised extraction, using trails and smaller
streams). Each of these has their own cost structure.

O They have a product unit price.

IwoPlan uses stand table projection as its basic growth
Growth models model. This is a simplified form of matrix model, in which
tree transition frequencies to the next diameter class are
calculated from mean increment rates. The general method
is described in detail in Alder (1995) . It is the same technical model as that used for the MYRLIN
model, which is documented online at http:/ /www.myrlin.org. (Alder et al., 2002; Alder, 2002),

Several species can share the same set of growth model parameters. The growth models are each
given a code letter (A-Z), and in the species list, the relevant code letter also supplied. This is
explain further in relation to the Species list and Growth models set-up menus, and the
configuration topic on growth models.

The growth models supplied with the demonstration data for Iwokrama forest are those
developed by Alder (2000) for the Guyana Forestry Commission, based on an analysis of
permanent sample plots established and measured by Tropenbos and Barama Company Limited.
The models for non-timber products are based on simple assumptions described in Alder (2001)
and Alder et al (2001).
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Case studies
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Three case studies are presented in this section to show how
Background information for IwoPlan can be set up and used to evaluate different
the case studies situations. These are conventional timber production via
mechanised logging, timber sawn at stump using a
manually portable technology such as chain saw with guide
bars, and production of canes and oilseed.

1t is important to emphasise in this section that the data used is imaginary, and not intended to
provide real arguments for or against any system of use. Relative costs, technical factors, species
use and the like are based on the authors experience and some reports and publications, which
are cited where appropriate. However, the primary purpose of this section is to demonstrate how
to set up and run IwoPlan, what kind of technical, cost and price data needs to be collected, and
how the outputs should be interpreted. It should also be noted that the resource data about
Iwokrama Forest, and its subdivision into management units, is based on interim work and may
not be currently accurate or valid.

The background information is that provided in the instaffation kit for IwoPlan, as described in the
Installation section. This comprises the river and stream maps, with provisional coding of
navigability and bridgeability; the map of the permanent road system; the map of forest
management units; stand tables of forest types from interim inventory results; and growth
models based on Alder’s (2000) work for the Guyana Forestry Commission.

All three case studies presented here assume that
Preliminaries: Checking the processing and sales will be based at or near the ferry over
processing base the Essequibo River at Kurupukari. To ensure that this is
. the case, please refer to the Setup » Transport network item
in the Menu reference section to see how to adjust the
transport network base. The example shown in the diagram there has the processing base
located at Kurupukari.

This case study examines the potential for producing and
Case study 1 ; Mechanised selling logs based on several high-valued species on a
logging sustainable basis. It is based on the assumption of

mechanical extraction and transport of logs to the landing at
Kurupukari, where logs could either be auctioned to other
companies, or processed in sitit by a mechanised sawmill.

Defining which species are commercial timbers

The first step in setting up this case study is to update the product codes in the species list. This
can be opened via the Setup » Species list menu (see p. 26). The code GH should be entered in
the Products field of the species list for Greenheart, and OT for other commercial species, which
we will assume are Purpleheart, Kabukalli, Locust, Aromata, Black Kakaralli, Crabwood and



White Cedar. Ensure at this stage that neither the GH or OT codes occur against any other species
in the list.

Setting product specifications for timber

The second step is to define relevant information in the Products specification table {(see Setup »
Product specification, p.27) . In the first row of this table, the codes GH and OT should be
entered in columns 2 and 3 (column 1 cannot be edited). Any other columns should be deleted at
this stage. Against Product name, enter Greenheart and Other Timber respectively. These product
names need to be kept short; they appear in graph legends and table headings, and the outputs
will be messy and unreadable if they are too long.

Against yiefd basis enter V {in uppercase) for both . This means that yield will be determined
based on stem volume.

Against yield multiplier, enter 0.7 for both GH and OT. This means that70% of stem volume, on
average, is actually extracted from the forest as logs. This allows for lopping of defective
sections, and meeting of length specifications. Clearly, for a real study, some information from
other commercial operations should be used to arrive at a supportable empirical figure. It would
however be excessively optimistic to assume that 100% of stem volume is extracted.

Price per unit, for volume based products, means price per m? at the point of sale or final delivery
(eg. FOB Georgetown). The currency unit is shownas $. This may be taken as either US or
Guyana 5, but it is necessary to be completely consistent. One cannot have some prices in US$
and others in GY$. For this case study, we assume all costs and prices are in USS. In this part of
the table, assume the Greenheart price is $70/m?, and other timbers average $60/m3.

The Units per standard load entry is directed
mainly at NTPPs and non-mechanised
transport systems. For timber it should be
enteted as 1 as all transport variable costs

. . x LI AN ootk ) 2 X i
will be given per m?. Product code GH o1 ¥
: | Product Greenheart | Other Timber |43
The Transport method should be entered as L .m e r.tame bkl E
(in uppercase). This indicates the use of ] Yield basis v v {4
mechanised logging and truck transport. &| Yield multiplier ’ 0.7 07 EF'
Price per unit 70 B0 r;‘

Post-harvest survival must be entered as zero. : 3
Units per standard load i 1 i

This factor is designed for NTPPs such as

each size class that occurs relative to
percentage of volume removed in
harvesting. Thus, if 30% of standing volume
were removed in felling, the model would,

. K
palm leaves, canes and oilseed whose Transpoft method ?'
harvesting does not kill the plant, but may '} Post-harvest survival ié
reduce its survival. For logging, tI.le tree is E{ Harvesting damage factor 9 1 .
necessarily killed and its survival is — — g
| Minimurn felling diameter 50 50 i

therefore zero. ;
7 | Harvesting cycle 60 60 L
Harvesting damage factor should be about1 il Retained stems 50 50
for mechanical logging. This is the ! Minimum stock 200 200 b
proportionate reduction in stem numbers in §
1| Allowable Cut ;
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with a HDF of 1, reduce all size classes of the remaining stand by a further 30% of their post-
harvest value to allow for felling damage. If the FIDF had been given as 0.5, then the further
reduction would be 15%. An HDF of 1 is good rule of thumb for typical mechanical logging,
provided that all or most of the volume is enumerated. This factor can be adjusted for local
techniques based on empirical information.

The Minimum felling diameter is the smallest tree that may be harvested. This may be either a legal
or economic limit, whichever is most effective. For this case study, we will assume that it is 50
cm for both types of timber (GH and OT). '

The Harvesting cycle is the minimum return period before a particular stand can be harvested
again. For this study, we assume the Tropenbos-Guyana recommendation of 60 years.

The Retained stems indicates the % of stems above the minimum size limit that will not be felled.
This may be considered a statutory conservation measure. It may equally be an empirical value,
based on defect rates and operational efficiency, reflecting the % of stems that are not actually
used. We will assume a value of 50% for both types of species.

The Minimum stock comprises the smallest number of stems per km? that must be present above
the diameter limit before a management unit can be considered viable for felling, This may be a
statutory conservation regulation (2 trees per ha, or 200 stems per km? is a figure used in Ghana,
for example). It may also be considered an economic limit. If average volume per tree is 10 m? (a
good rule of thumb for Guyana), and 20 m?/ha is the minimum economic harvest with
mechanised logging, then again 2 trees/ha (200 trees/km?) represents an appropriate minimumn
for entry. For the case study, we will assume this figure of 200 trees/km? is realistic.

The allowable cut determines the yield target which the model will try to maintain. This may be
limited by the size of the available resource, or by constraints on marketing, processing and
transport. For the moment, we will enter a figure of 50,000 m3 for both the GH and OT columns,
but will come back to discuss this further in the section Estimating the allowable cut. This figure is
the volume that will be allowed to be cut per 5-year period.

The Product specifications form should be closed by clicking the OK button. If the form is closed
using the close window box, Ciri-F4, or the Cancel button, changes which have been edited into it

will not be saved.

Defining timber production costs

The menu Setup » Transport costs
brings up a dialog form that allows cost
information relative to timber
extraction and processing to be entered.
The transport costs for timber for the
case study are based on typical figures,
but clearly this data needs to be defined
as accurately as possible.

Planning costs are applied per ha in the
time period when an MU is actually
harvested, and include inventory, stock
survey, detailed road design, and supervision and overhead costs for logging. A typical value of
$30/ha is used here.

10



Costs of felling and processing at stump, for a simple logging operation, include chainsaw costs,
operators wages, and chainsaw and labour costs relative to cross cutting, and are given per m? of
felled volume. A typical figure of $2/m? should be used.

Skidding and forewarding costs include all the running costs of skidding: fuel and lubricants, wages,
and maintenance, but not capital costs. These must be expressed per m3 extracted and km
hauled. These are quite sensitive to the type of equipment used and the efficiency with which it
is managed. The cost of $20/m3/km would probably typify catepillar logging and be at the
higher limit.

Yarding, loading and transhipment costs are expressed per m?, and include an average cost for either
loading onto trucks, or transhipment from road to river transport. For the case study, an
estimated figure of $2 per m?® should be used.

Road transport is expressed per m? per km carried. For the case study, 1 $/m?/km should be
used. River transport is applied in the same way, and uses the same estimated costing for this
example, although in reality the figure is likely to be lower. Note that road and river costs are
strictly operating costs, and do not include infrastructure development or maintenance, which
are accounted for elsewhere.

The final delivery cost is the cost of moving timber from the processing base in the transport
network (Kurupukari in this case study) to wherever it will finally be sold. As the product prices
are approximately FOB Georgetown prices for logs {according to GFC 2000 market reports), the
cost of transport from Kurupukari to Georgetown is used, which was about $30 per m? in 2001.

and Wanzpoit cosls
i .

Infrastructure costs are set on the third N Harvasting
tab of the Transport costs form, as T
illustrated, and include the construction
and maintenance costs for roads and
bridges. They also include the costs for
making rivers navigable and
maintaining them in that state, and the
costs for cutting and maintaining trails
for animal or foot transport.

Road constriction costs are specified for
two classes of road. The minor roads -
exist within MUs, are termporary in nature, and are not maintained after logging. They are not
explicitly mapped by IwoPlan, but are calculated only on the basis of a road density factor. The
major roads are also forest roads, but they are maintained in use for more than one 5-year period.
These roads are mapped by IwoPlan as it extends the road network. For the case study, it is
assumed minor roads cost $5,000 per km to construct, and major roads cost $12,000 per km.
Maintenance on major roads is assumed to be $1,000 per km per year.

It will be noted that the permanent road network construction and general maintenance costs, as
indicated by the road map, are not costed by the model on a production-related basis. This is
because they may have public use or ownership, and will therefore be supported by external
funds. If charged to some extent to the project, they must be regarded as an overall fixed cost.

However, the model does apply the maintenance cost factor to any sections of the permanent
road network that are in use for haulage of timber or other products.

11
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Bridge construction costs likewise fall into two classes, as discussed in the menu reference section
Setup » Transport costs. For smaller bridges, a cost of $6,000 each is assumed, whilst for larger
bridges, a cost of $12,000 is given.

Options for running the model

The Setup » Options menu brings up a dialog to look at some general options. For the purposes
of this case study, please follow the settings shown on the diagram in that section. The Time limit
should be set to 100 years, and the inifialize automatically box checked. The Selection policy should
be set to Lowsst unit cost,

Viewing timber production potential

The distribution and quantities of available timber can be viewed via the Products distribution form.
See the Menu reference section for details of the use of this form. The figure below shows the
initial distribution of Greenheart and Other Timber!.

173005 he

! I
Greenheart F'w e i?gq . Other Timber

These maps show the net amounts available, respecting the retention %, minimum felling
diameter, and minimum stock criteria given on page 9. They also include the effect of the
conversion percentage (yield multiplier) relative to standing stem voluune.

It will be apparent that this side by side comparison shows average harvestable stocks of
Greenheart to be 6.6 m3/ha, whilst the other timbers average 3.7 m3/ha. The total area under
management is 173,000 ha, with available stocks of 1,140,000 m? of Greenheart, and 634,000 m3 of
other timbers. It is apparent from the maps that there are parts of the forest where net Greenheart
stocks are close to zero, and which are therefore urnlikely to be suitable for timber exploitation.

Viewing simulated harvesting and coupe allocation

We can now run the model, via the Run » Start menu. If the options have been set up as
previously described, then viewing the Harvest Plan map will show a pattern of coupes similar to
the map below. Because of the option settings, this represents the most cost-efficient harvest the

1 This map has been composed by cutting and pasting from the IwoPlan maps. This can done with a frame grabbing tool
such as Screen Rip32, or by using the PrtSc key to save the screen to the clipboard. This can then be manipulated using
Windows Paintbrush or a similar utility.

12



model can calculate, and should be used as a
baseline is assessing basic financial feasibility
before considering constraints that may need to
be imposed to protect tourism and amenity.

It will be noted that the model favours
harvesting close to the road and Kurupukari
under this option, because this minimizes

’ Vs . (1 Do irm VIS -
transport costs. The years of harvesting are ffear of harvesting
. 1 . . B _ 10003
indicated by colours, with yellows being ; i

harvested first, then greens, blues and purples.
This simulation covers a single felling cycle (60
years) to avoid an unduly confused picture on
the map opposite. :

Timber yields

The figure below shows the timber yields for
Greenheart and Other species projected over one
rotation. The histogram has been created by copying the tables from the Product yields form for
Greenheart and Other species into Excel using the Copy function, and then producing a stacked bar
chart from the data.

80,000 C1omer Tirbar {m3) | ]
= Greenheat (3}
e 30,500 13y
50,000

5
8
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Timber satracted {m3}
k-] a
g B8

e
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S

15 30 35 40 L] ] 5 L
Patled ending {yeat}

It will be seen that total harvests are mostly between 35,000 and 45,000 m? per 5-year period, with
a mean of 39,500 m3. It will be recalled that on the products form, the allowable cut was set at
50,000 m? for both Greenheart and Other Timber. IwoPlan generally cuts below the stipulated
allowable cut because it can only process whole units in a harvesting period; it will not start to
cut a unit if the result of felling it would be to exceed the allowable cut.

With mechanised logging, the allowable cut issue is further complicated by the fact that the two
products are treated as a single item for management purposes, because one cannot
mechanically-log one coupe for Greenheart, and a different one for Other Products. This problem
does not arise with NTPPs and manually extracted timber, where each product will be operated
independently. It will also be noted for mechanised timber products that the periodic allowable
cut (PAC) will be taken as the largest stipulated PAC for any of the products listed as having the
L-type transport method (see Product specifications above and explanations in the Menu
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reference). It is suggested therefore that to obtain a given PAC, a degree of experimentation may
be required on the Product specifications form.

Sales, operating_ costs, and financial viability

Total sales, total costs and net revenues are shown on the Net sales graph of the Sales & Finance
menu. The graph for this case study scenario is shown below. All the values shown are totals
per 5-year period, in $'000s. Sales (black line) fluctuate between $1,000,000 and $1,500,000 per
period, whilst costs (red line) gradually rise from $500,000 to $2,000,000. Consequently, the net
revenue per period declines
and becomes negative ( a net
loss} after about the 30t year.

2500 . . 2500

- -4 2000
The reason for the increasing :
costs can be seen by
examining the logging costs
details,as shown in the graph

- 1590

< 1000
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below. Whereas harvesting o
costs remain constant over .0
time (green), and i
infrastructure development Sl
and maintenance (blue) only .1000 - > s‘{;‘ 1000

s 10" 15 20" 25 30 357" 40% 45! 50! 55

rises slightly, the transport Time fyeams)

costs rise steeply (red). These
costs are linearly related to b= Totalsales§ = Tolalcosts$ w= Hat sales §
haulage distance, and as
operations move further from the base at Kurupukari, they rise substantially. It is essentially this
haulage distance increase that moves the project from being profitable in its early years to giving
a net loss in the later years.
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2500 - s The unit cost of production,

Vs shown by the magenta line and
2060 - L read against the right axis, rises

‘ from around $20 per m? initially,

to over $50 per m? at the end of
the rotation, due to this rising
transport cost with increasing
distance.
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Given the uncertainties of long-
0 ‘ _ " term matkets, costs etc., and the
Psiw o sTo 25 0" 5 wis o sle fact that the above projections

Time Grears) suggest the project would move
into a loss after 30 years, what
would be the return on capital if

Havesting$ == Trarsport § v Infrastiucture $ = Totaleost$ ma Unit cost §
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| S

| MU [S——

the project was run only for, say,
20 years? This would be an appropriate period to write off logging equipment and timber trucks,
and might be a profitable operation, whilst leaving future options open. This can be checked by
changing the projection period to 20 years on the Options form, then re-running the model. The
results, in terms of return on capital over 20 years, can be seen by viewing the Capifat & IRR graph
on the Sales and Finance form. This suggests that at a 10% borrowing rate, the 20-year income
stream could support a capitalisation of around $700,000. It appears very likely that such a
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project would be feasible.

Mechanised production of $40,000 m?
per 5-year period, or §,000 m3 per
year, requires a single skidder, or

D 1200 ~ i . : even a suitably adapted agricultural
N ' . . . .
WA000 4 -+ o omomme NG e e R tractor with logging winch, and
5 g j timber truck, and could probably be
- capitalised at $250,000.

400 . ;

20 | Sensitivity analysis

84— -

Co T2 T4 e 18 T 2T T1s 18t 20 221241 | Ttis desirable in this type of study to
Intavest rate % re-run the model with higher and
: lower critical costs and prices. The
critical cost is clearly haulage, which has two important components: The road transport cost
(initially estimated at $1 per m? per km), and the final delivery cost from base to point of sale
{estimated at $30 per m3). The prices are assumed to be $70 per m? for Greenheart and $60 per m3
for other timbers. The graph below shows the net revenue using the costs and prices noted
above, an Optimistic scenario, with 10% higher prices and 10% lower costs, and a Pessimistic
scenario, with 10% lower prices, and 10% higher costs. The sensitivity of the results to these quite
small changes are evident, and emphasise the importance of obtaining accurate estimates for
critical data if the model is to lead to appropriate conclusions.

1,500,000

e slandard
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1,000,000 - -\\‘__,\ = passimisic

500,000 -

0 \ . . T . S,
N

Net revenue ($)

-500,000 4
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-1,500,000
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Conclusions to Case Study 1

This case study examines a rather small mechanised timber business, using costs and prices that
are as realistic as possible. It shows that under some circumstances, such an operation could be
viable, but it would be by no means a license to print money, mainly due to low FOB prices for
roundwood and high transport costs. This case study does not explore all the issues that IwoPlan
could and should examine. For example, some management units with this type of operation
should be protected to minimize tourism and visual impacts (the method of doing this is
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described in relation to the Harvest Plan menu). What effect would this have on costs, as it
would inevitably tend to increase transport distances? Would the relatively marginal returns
from mechanised logging be outweighed by costs external to the model, such as impacts on
tourism? If more species were used, and PAC set higher, would there be economies of scale that
would improve viability? If wood were reprocessed either at stump or at Kurupukari to give a
higher unit price (but, or course, lower net yield) would these be advantageous and improve
viability? These and other issues need to be examined more fully for a complete evaluation of
options.

In concluding this case study, the author would also draw attention again to the Disclaimer. The
results indicated here are purely to exemplify the use of the model, and do not imply any
suggestions for actual management, as the base line data used is not current, and the costs and
prices are too suppositional.

Case study 2 : Timber This case study contrasts the mechanised extraction and
processed at stump with marketing of logs discussed in Case study 1 with an
manual extraction alternative possibility. This involves felling trees and

converting them into sawn boards in situ, and then

extracting them by river or pack animals, The advantages
of this approach are usually stated as the negligible capital required (essentially only a cash float
for operating costs), the elimination of the need for a substantial road system with its high costs
and environmental dis-benefits, and the efficiency of reducing bulk and adding value at tree
stump. It also requires less organisation and forest management planning, and can be directly
implemented by local people with only limited training.

Information about the use of IwoPlan referred to in Case Study 1 will not be repeated in this
section except where directly relevant, and the reader is therefore advised to work through that
case study before considering this one, even if they regard it as of little direct practicality.

Specles and product specifications

Far simplicityand direct comparability, it will be assumed that the same species as considered in
case study 1 are used, namely Greenheart, White Cedar, Crabwood, Kabukalli, Purleheart,
Aromata, Locust and Black Kakaralli. The Products column of the species list should be amended
to add an additional code, CSL (for chain-sawn lumber), to each of these specics. The figure
opposite shows how this would ; .

appear after amending Purpleheart iF
. . 4R
and Kabukalli in this way. 3 : Cenlroloblum paraense  Tree ' E
’f Epetua falcata Tiee M
e g . Il Watapa , Eperua rubigingsa Tiee E
The product specifications need tobe 5ot Merikara bdorias ~ T 5~~~
amended to reflect differences in | white ceder | T abebuia insigris Teee'C 0T
h . . d \ Crabwood +Catapa guianznsiz Teee K 0T
arvesting, processing and extraction  lp Viola spp. Tiee F
technique. The required amendments | Kabukall _Gouplaglabia  Tieg  OTESL
. P . | Mora Mara excelsa Tree J
can be seen in red in the next figure.  Fieil Licaria canells e
‘ | Wamara ,Swallzia iocaleing Tree J
. : : il Purpleh ‘
Firstly, a new column is added, using || gorene t;:::::;; anyretola Tree s TSt
the Ctrl-Ins key. The product code for  [locust = “Hymenea coubail  Tree N~ 87" -
A fnit
the new column is amended to CSL, {{orebukea . Mora qongaig Troe L
and the product name to CS Lumber
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(CS standing for chain-sawn). Then some of the entries are amended, by comparison with the
Greenheart entry from Case Study 1.

3 Praduct specification

The yield muitiplier, which gives the ratio of

- extracted to standing volume,is reduced to 0.2 Y T e P R L S T
(20%). Tkus assumes that on average, after * Product code CsL CGH |
conversion at stump, 20% of the original stem | Product name CS Lumber | Greenheart [
volume will remain as sawn boards. The unit = - y v
price for the sawn boards is given as $400 per m? é Yield bas'_s
(FOB Georgetown). This reflects typical prices ] vield mutipter 0.2 07
for air-dried boards according to Guyana % Price per unit 400 70
Forestry Commission market reports. % Units per standard load 1 1

T t method N L
The units per standard load are left unchanged at 1. | ransport metho -
In other words, cost, price and product i Post-ha{vest survival 0 :
calculations are again carried out in terms of m3,  § Harvesting damage 0.5 1
For further discussions of this, see the relevant | Mirimurn feling diameter 50 50
menu reference topic. Harvesting cycle B0 60 1
The transport method is changed from L-type to N- H‘et.euned stems 30 100
type. N-type transport implies the use of the Minirmum stock 200 200 {3
NTPP extraction cost template, based on manual, g Allowable Cut 5000 o[

animal or small boat extraction, without
construction of roads, although trails will be
constructed as necessary.

The harvesting damage factor is reduced to 0.5. This is arbitrary, as the author has no knowledge of
studies of extraction damage for this type of harvesting, but is substantially less than for
mechanised logging, with its associated skid trails and log-length extraction. Damage will not be
zero, however, as tree fall gaps will still be created, and the conversion of the bole will necessitate
clearing a good deal of undergrowth, including regenerating poles, for proper working space
around the felled tree,

The retained stems are left at 50%. However, retained stems for the GH and OT products should
be changed to 100%. This effectively switches off harvesting of these products. Aflowabfe cut for
the CS Lumber is set to 5000 m? per 5-year period. This is based on assessment of feasibility
without creating a visually intrusive industrial infrastructure at Kurupukari. It is equivalent to
about 85 m3 per month, or about 10 medium-sized truck loads of sawn boards being transported
to Georgetown on a monthly basis (obviously with some adjustment for seasonal transport
conditions).

Allowable cut for GH and OT timbers should be set to zero. This, together with 100% retention,
will switch off the harvesting of these products, so that only the CS Lumber will be harvested in
this scenario.

Transport costs

The suggested transport costs to use in this case study are given on the NTPP tab of the Transport
costs form. This appears as illustrated below. The units referred to in this case will be m?,
because of the setting of 1 on the Units per standard load entry of the Product specification form, as
shown above, and the Yield basis being indicated by V (stem volume). Porterage costs are set at
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$20 per m? per km. A horse or donkey would normally require about 20 trips to carry 1 m3 of
lumber a km (assuming 50 kg loads), and a relatively high figure seems appropriate for this. Road
fransport costs about $1 per m? per k. River fransport is estimated at ¢50 per m3 per ki, or about
half the cost of road fransport. The Infrastruciure costs are assumed to be the same as for cost
study 1, with the critical values for this simulation being $50 per km per year for maintenenace of

river routes (mainly relative to
cataracts and landings), and $5
per km per year for trails. It
will be noted that IwoFlan
only applies a maintenance
charge for trails and river
routes used in any given 5-year
period, but it will apply it over
the whole 5-year period, which
for many trails for lumber
exfraction may be excessive.

Harvesting plan

To protect sensitive tourism
areas from timber felling
activities, management unit
protection can be applied to
the harvest plan form. The
scheme applied for this case
study is shown in the map at
the right as a darker gray

shading, and covers units along the Essequibo River and the main road close to Kurupukari. The
units are marked for protection by (a) ticking the Exclude selected MUs box on the Harvest plan
form, and then (b) clicking on the required units with the Ciri-Left mouse button (see also the

18

menu reference topic regarding mouse
controls on maps).

If the simulation model is run over 100
years with the above settings, and with the
selection policy on the options form set to
Lowest cost, with the Aggregate MUs
checkbox cleared, then the harvest plan
map shown above should be seen.

It will be seen that management units occur
mainly along navigable rivers and the main
road. The ribbon development along the
road can be suppressed by increasing the
selection of protected coupes (dark gray).
Units operated in the same year are
scattered in different locations. A more
concentrated and easily managed pattern
would result. This is shown in the example
at the left, which is the basis for the
financial and production analysis. In this



example, the entire road has a protected zone on either side, to reduce visual impacts, as does the
area along the Essequibo River. The harvested management units in each period are all adjacent,
making planning and control easier. Otherwise, the options and costs are as described above.

Financial analysis

Production over one rotation (60 years) for the above scenario is shown below. It fluctuates
mainty due to the selection of units, and could be smoothed out by making some adjustments to
this. The allowable cut was stipulated as 5000 m®. Production is actually between 5000 and 7000
m? in most periods. This is net product of processed boards, and is equivalent to around 25,000-
35,000 m? of felled tree volume (given the conversion factor of 20%).

8000 ~ 2000
7000 | 1800
1 1600
o €000 -
g N 1400
5000 =l 1200 ,
L
. 4000 1000 *
m
B 3000 800 a
e 1} 600
* 2000
: |- 400
1000 1 200
0 : | | 0
s T 1ot 15l a0l as T agl as T aol sl sol 551 g0

Time (years)

— CS Lumber (m3) == Areafha)

Sales, costs and net revenues are shown in the table at the right, taken from the Sales & finance
menu. These show a sound financial position that is sustained over the rotation, with net
revenues of around $1.5-$2 million

per 5-year period. This is not very Pertiod (end yr) Total sales $| . Totalcosts $ MNet sales $
sensitive to any aspect of transport 5 1,003,189 208,448 794,741
costs, as tht; reader may Verilfy by 10 1,985,992 #5622 1,570,370
ting the sensitivity analysis
::flfgiqu% desiribed fo?(thé p};evious 18 2693392 387959 2311433
case study. 20 1,940,773 453,133 1.487.640
25 1,856,783 292,711 1,564,071
The chart of discounted net revenue a0 1,950,896 341,368 1,609,528
suggests that_zt 10% intt‘-}"tzitr antg " 3% 2,256,758 366,361 1,888,397
thout considering ca ’
DNW of this incomge e ¢ 40 1,964,361 320291 1,644,069
years would be of the order of $2.7 5 2.208545 379,028 1.827.517
million. Over the first 20 years, of the 50 2,462,158 377.115 2,085,043
project it would be $1.9 million. 55 2516,899 EEE.169 1,850,730
B0 2,078,551 463,535 1,615,056
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Conclusions regarding case study 2

The chain-sawn lumber operation analysed here is considerably more profitable than the
mechanised logging operation examined in case study 1. Capital requirements would be limited,
as almost all operations could be subcontracted. Visual impacts, and environmental impacts
from road construction and erosion would be very much less. Supervisory and training
requirements would be much simpler. The price used ($400 for air dried lumber) corresponds to
averages from GFC market reports, and would be realistic, It is probable that with care, using the
Iwokrama brand and with certification, a premium price could be obtained.

This case study is however, only intended to demonstrate how IwoFlan may be used to examine
such questions. Transport costs and conversion rates need to be verified, and the species to be
used carefully judged. The baseline data used here is weak with regard to some aspects of the
inventory. The classification of stream navigability is also insufficient in these data sets (being
based purely on stream order) to properly evaluate options based on river transport.

Case study 3 : Canes and This case study examines the viability of NTPP businesses
oilseed based on the production of canes from Nibbi and Kufa, and

of essential oil extracted from the seed of Crabwood
(Craboil). For these studies, the costs employed are very
tentative, as they involve searching, gathering, and quality selection activities in the forest.
Market prices could also vary widely, depending on the efficiency with which Iwokrama could
leverage certification and branding to obtain price premiums. The growth models and the
resource data in the present version of IwoPlan and the associated demonstration files also need
to be amended for a proper study of availability and sustainability with respect to canes.

Species and product specifications

To accommodate this case study, the products column of the species list form for Nibbi and Kufa
should have the code CN (for canes) inserted, and Crabwood should have the code OS {(for
oilseed).

The product specifications form should be amended so that it has two columns, set up as shown
in the figure opposite. The product codes are CN and OS, which correspond to those for the
respective species in the species list. The product names given are Canes and Oilseed. The yield
basis is calculated relative to stems (N) for canes, and relative to tree basal area (G) for oilseed.

For canes, it is noted that the URS (2002) report on cane production at Iwokrama estimates an
average of 35 pieces of 4 m cane per ha, corresponding more or less on a 1:1 basis to stem counts.
These are normally bundled into 100 pieces for transport and marketing, which is therefore
defined as the standard load. A yield muitiplier of 0.01 relative to stem count is therefore used in
the table opposite, where the unit of yield is a bundle of 100 pieces of about 4 m length.

For oilseed, there is some published information from Brazil on Andiroba oil (Andiroba being the
Brazilian name for Crabwood). Using the assumption that seed production will be proportional
to basal area (the latter being itself proportional to crown area), and noting in Plowden (2001)
that average production from several sample trees for 20 to 70 cmn dbh was 0.8 kg per season, it is
estimated that the average production per m? of basal area per 5-year period will be around 30
kg. Itis further noted from Plowden (2001) that 30kg of seed yield about 1 litre of refined oil.
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For craboil therefore, a yield multiplier of 1 is & Product specilications _
-GS B L BT L i ) AL T B e e *._._ X AL

used, with the units being litres of oil. This is F
discussed a litile further in the section on 4| Product code

transport costs. %l Product name Canes Dilseed %
_ o % Yield basis N G E
Prices for Nibbi and Kufa are quoted by the il Sieid multpler 0.01 1 ‘

URS (2002) report as being around ¢5 per m
length for small diameter, average quality
material purchased by middlemen. A bundle
of 100 pieces of 4 m length would therefore

Sy

ol Price per unit 20 25
| Units per standard load 20 33

B Transport method N N i
have a conservative price of around $20. For g;l Posth tsurvival 0 ] ;Ei_
craboil, price is a matter of conjecture and f osthaives' Surviva E
marketing, but are likely to be of the order of £l Harvesting damage factor g 0 |
$20-%30 per litre. A flgl.u‘e of $25 is used % Minimuen felling diameter 0 ,Lﬁi
initially. Harvesting.cycle 20 20 ' ;
The units per standard load are defined here :-J Retained stems o |
relative to a metric ton, to allow the same & Minimum stock. 0 |
transport costs as were used in case study 2 to [ Allowable Cut 1} :
be applied. For canes, assuming a 100 p¢ 7T

bundle weighs about 50Kg, then there may be
20 units per ton. For craboil, a litre of oil is
derived from 30 Kg of seed carried to the
processing centre, or approximately 33 units (of 30 kg seed) per ton.

The transport method for both products is defined as N, implying a product with non-mech nised
extraction and harvesting, river transport by small boats, and overland transport on porterage
trails up to the existing road system.

Post-harvest survival is zero for canes, which are cut and harvested. For oilseed, which is derived
from seeds falling to the ground and collected, there is no impact on the parent tree, and survival
is 100%. The harvesting damage factor for both these products is zero, because there is no impact
from harvesting on the residual stand. The minimum feiling diameter is likewise given as zero for
both types of product as there is no constraint of this type imposed.

A harvesting cycle for both types of product of 20 years is suggested. This implies that a coupe
will be rested for 15 years after being harvested for 5 years. For Nibbi and Kufa, this will allow
the plants to regenerate. For Crabwood, it will allow seed to become established to ensure
continuity of the crop. The most appropriate cycle does however require some scientific analysis.

Retained stems and minimum stock for both products is set at zero. It is assumed that the above
harvesting cycle provides a sufficiently generous protective measure. It is unlikely to be possible
to police any more complicated conservation measures for this type of product.

The aliowable cut will be estimated as discussed in the next section, and can be given as zero
initially. The Product specification form at this stage should be closed with the OK button to save
the settings, and the model initialised.

Estimating allowable cut

To estimate maximum allowable cuts for the products, total product stocks can be examined
from the Product distribution map. The table will at this stage show total stocks for canes of
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about 34,000 units (ie bundles of 4 m pieces), and for oil seed of 143,000 units (je. litres of
extractable oil). These should be divided by the rotation to give annual equivalents, and
multiplied by 5-year periods to express allowable cuts per period. Thus maximum allowable cuts
would be around 4,250 units for canes and 35,750 units for oilseed.

These figures would imply however covering the entire managed area of the reserve (173,000 ha)
over a 20-year period. As an initial assessment of feasibility therefore, this case study examines
operations at a smaller scale, aiming to produce 200 bundles of canes per annum, and 1000 litres
per annum of oil. These correspond to periodic allowable cuts of 1000 and 5000 units
respectively for canes and oilseed, which should be entered in the product specification form as
shown above.

Transport costs

It will be noted as discussed previously, that the units per standard load factors on the product
specification form should be 20 for canes and 33 for oilseed. These will give standard loads of
approximately 1 ton in each case. This allows the same transport and infrastructure costs as used
in Case study 2 to be applied. In that case, calculations were based per m3, but a m? of green
wood is approximately equivalent to 1 ton. However, for this case study, it is assumed that the
prices are based on sales made at Kurupukari. The delivery cost to from base to final destination
should therefore be given as zero.

Harvest plan

The figure opposite shows the harvesting
plan for canes after 60 years (3 rotations).
Some areas are protected around
Kurupukari (shown in darker gray}, so
that the gathering activities do not impact
on the immediate vicinity. The coupes in
the same 5-year period are shown in the
same colours. Although coupes vary
between rotations to some extent, the
general pattern is similar in each cycle, and
the total exploited area does not extend
greatly.

The pattern of coupes for oilseed is very
similar. The model is predisposed to work
in the same areas when two or more
products are planned simultanecusly
because of the economies involved in
sharing the infrastructure of trails and

river improvements. Had this exercise mcluded mechamsed Ioggmg, it would have been seen
that the location of forest roads would greatly influence harvesting patterns for NTPPs.

Financial analysis

The table of sales, costs and net revenue shown overleaf for the two products indicates that the
operation would be quite profitable, yielding net about $140,000 per 5-year period ($28,000 pa).
About 85% of the sales value is due to oilseed, and 15% due to canes.
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Sales, costs and net revenues from Case Study 3

Period [end yr) Canes $ Oilseed $ Total sales $ Totalcosls $ Net sales $
5 20,406 128,645 149,051 8,967 140,084
10 20,934 144,227 165,161 11,473 153,687
15 21,848 126,558 148,407 1,111 137,296
20 20,130 125,405 145,535 12542 132,993
25 20,841 " 26558 147,358 3,499 137,901
30 . 20,789 137.586 158,376 11,504 146,772
35 23,654 127,580 151,244 11,343 139,300
A0 22,145 135,342 157.487| 13,874 143,613
45 20,840, 125,232 146,072 9,337 136,675
50 20,789 130,094 150,883 11,150 139,733
55 23,659 135,883 159,542: 12,202 147,340
60 20,562 128,388 148,350 13,278 135,672

General conclusions for case

studies

IwoPlan allows the general feasibility of different types and
scales of operation to be examined quickly and visually, as
shown in the three case studies discussed here. These are
designed primarily for training purposes, as the costs, prices
and baseline data all need to be verified. The obvious conclusion that arises, namely that
mechanised logging would be unprofitable, chain saw logging the most profitable option at a
corporate level, and gathering of oilseed and canes also financially viable, could be regarded as
valid based on the data presented and used here. However, attention is again drawn to the
disclaimer, and the reader reminded that these exercises are for the purpose of exemplifying the
use of IwoPlan; the data is in many respects incomplete or suppositional, and it is not the
purpose of this manual to provide real-world recommendations.
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Menu reference

The menu system of IwoPlan is shown in the figure below,
The menu system as it would appear fully expanded. The various menu
items are explained below.

IwoPlan 1.01 : lwekrama Sustainable Use Planning Mode!

; TSI, S o e .<"-ﬂ:’ .ﬂ,ﬁ:ﬁ Eqﬂ_,.”&.,,, - 2
Bl ﬁstiﬂﬁ% tsa;u A E?H i Qg

;ﬁgtgml'r.v‘gﬁ*ﬁ-'umm; MCTHL T

File » Baseline data

The baseline data menu brings
up the dialog form shown
opposite. This sets the
directories which contain the
scenario and geodata files, gives
the names of the geodata files
for each type of map layer, and
gives the names of the attribute
fields associated with each file.

These data are technical and
would not normally be changed by the ordinary user once a project has been configured. The
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Configuration section discusses in detail how the map layers and their attributes should set up,
and the directory structure and files required by the program.

File » Open scenario and File
» Save scenario

The Open scenario menu brings up a standard Windows file
open box, which allows a scenario file to be located. These
have the extension *.iwp. When a scenario file is opened,
its contents will replace all the settings in the program with
those in the file. Normally, scenarios contain mostly the

same configuration data (map layers, inventory data, growth model, species list) and will differ
from each other only in the particulars of management, products, prices, and costs.

The Save scenario menu likewise brings up a dialog to save a scenario file. This can be given any
name, and will have the extension *.iwp. This will save all current settings and options in that
file, allowing them to be retrieved at a later date.

IwoPlan uses a default scenario file called ..\ SCENARIOS\ DEFAULT.IWP (where ..\ is the directory
containing the IWOPLAN.EXE program) when it starts up. This file is also always saved with
current settings when the program is closed down. This gives the program continuity between

one run and the next, as it always appears to remember its settings from the last time it was used.

File » Copy

appropriate size.

The Copy menu is the main method for transferring data

from IwoPlan to ancther application. The map below, for
example was transferred into Word using the Copy menu,
with the default Word paste (Ctrl+V) with a textbox of an

The way Copy works will depend on the
form open at the time. If it is a map (Check
map, Species distribution, Products distribution,
Harvest Plan) then the map is copied as a
Windows metafile.

If it is a graph, then both the graph and its
underlying data are copied. Using Paste
Special in Word or Excel, either the image
may be pasted, or the data. The latter is
particularly useful in Excel, where the data
will be pasted directly as a spreadsheet
table.

The Exit menu will close the program and return to

Windows. When this is done, all current settings are saved
automatically in the file DEFAULT.IWP. Note that closing the
main IwoPlan window has the same effect as the Exit menu.

File » Exit -
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The Species list menu brings up the species list table, as

Setup » Species list shown below. This provides information about species, and

can also be edited, as noted below. The Configuration
section provides a fuller discussion of the species list in
relation to mventory data. Here it should be noted that the Code should not be edited, or the link
W1th ’r_he mventory data f]lE may be lost or mlxed up. The Iocal and botanical names can be

edited as needed. The Type of
TEe: T [Deranical same. [Ty ne ] Hasda] Froduste = plant and the growth Modsl are
1 .Guadua angustifolia Grass' A .
2 [RomnwiGies  Trechwpogmphmous  [Grass A links to the Growth models form,
HIESERLL:: . Hetetopsis spp, Misna & IN
10 s - Hocomss | o and should also not_ nor‘mally
{10 Mariccla Edtepe pp. {Polm A be edited after configuring the
20 s Mauitia flesiasa Pam A N
E g Yo Fan A model. The most important
50 [Avapipi Astrocawm vulgare Palm A ] :
il i iy Pan A field for most users is the
| 70 jBuba ; Soctoloa ewonhiza Pan A Produocts field, which can be
80 [Tunu { Denocamus bataus Pain A | . !
# 101 | Breenheat __ Crlotocatdiu todis Tee M 1) — edited to create new products,
5108 Mud . Humina balsamifera Tree E th 1 - h
120 | SandpapetTres Curalella americana Tree E or to remove e relations. 1P
i 150 | Kornoko Licaria cupea Fran 3
1] 188 |Dakama Dimorphandra conugata Tree E bEtWEen a Parucular prOduCt
200 | Kartang  Certiolebium pataense Ttee E and the species concerned,
202 Wallaba Eperua falcats Tree M
~ = Several products can be listed

for each species. For example, Carapa guianensis (Crabwood) could have the entry TI, OS,
indicating that it produces both timber (TT} and oilseed (OS). The product codes are defined in
the Product specification form.

Editing fields in spreadsheet-like forms

It will be noted that the Species list, as above, the Growth models, and Froduct specification forms all
appear somewhat like a spreadsheet. The all use the same method to edit data. Double-click on
the required cell and it will change to a pink colour. In this style it can be edited. After making
changes, press the Enter key, and the changes will be saved. Simply moving to another cell, or
closing the form while the edit mode is still active, will not save the changes.

It should also be noted that if this type of form is closed by using the Window close box or by

pressing the Cance/ button, any changes made will be lost. The form must be closed with the OK
button for changes to be saved.

Setup » Growth models

The Growth models form appears
when this menu item is pressed, as
shown at the right.

For each defined type of plant form
{trees, lianas, palms in the present
version), a list of models will be seen.
Each model refers to one or more
species, with the model code
indicated by a single letter. There i 3=
are four parameters for each model. Average diameter increment (Dinc), annual mortality rate
(AMR}, 95% cumulative diameter (Dmax), and the form height (Vf), or volume/basal area ratio,

|

T T T ST mogme i
Timimimio|o|e|> SEEET
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are required for trees. The Concepts and Configuration sections discuss in more detail the
conceptual basis of the models, and how they may be set up.

The entries in the Growth models form can be edited as noted above (see Editing fields in
spreadsheet-like forms). However, normally growth models will be defined directly in the
default scenario file (DEFAULT.IWP) during the configuration process and will not be altered by
users. See the Configuration section for further details.

The Product specification form appears as shown below. This
form is central to the effective use of IwoPlan, as it defines
the types of timber and non-timber products, their yield
characteristics, prices, transport method, management
constraints and objectives, the influence of harvesting on survival {including logging damage, for
example). The Case studies section gives detailed examples of the use of this form, whilst the
Concepts section deals with the underlying ideas. The various entries in the form are explained
briefly below. The entries are edited using the method described in the section Editing fields in
spreadsheet-like forms above, Note that changes are saved only if the OK button is used to close the
form,

Setup » Product specification

i % F‘mduct sp
Product code T
The product code must link with the Products #{ Product code T s | CN
column of the species list. The codes can be El Product name Timber | Craboff | Canes
invented as required, and should preferably | Yield basis y G N .
be short. Case is significant, so a code of plis  §{vield multipher 0.7 25 1
not l{j:‘;\e same as 1I:]LI. To avoid p?ssible . Piice per uni 100 "
problems, use only uppercase letters an Bl Grts per standard ] 03 05
numbers, ] —

£ Transport method L N N
Product name ’ Post-harvest survival | 0 0
This name appears on various screens when Harvesting damage 1 0 0
selecting or reporting results for the product. f} Minimum feling 50 0 0
It should preferably be fairly brief (around i Harvesting cycle g0 20 20
20 letters maximum) to avoid formatting 2 Retained stems 50 0 50
problems. /| Minimum stock 200 0 1000
The yield basis for a product can be volume
inm? (V), stem basal area in m? (G) or per

stem (N). This basis is then multiplied by the i Sl SRS e =
yield multiplier to get the actual yield per stem. Timber will mvanably have a volume baSIS v )
Other products may normally be calculated relative to stems. For example lianas will have a yield
per stem. Seeds, resins or other products that may be related to tree size can be specified as per
unit basal area if sufficient data is available to develop such an allometric ratio. Entries other
than uppercase V, G or N will be treated as N.

Yield multiplier

The yield multiplier is used to calculate the actual yield for the product, in whatever units are
appropriate. For timber, this will represent a recovery factor for product taken out of the forest. If
boards are sawn at stump, then a factor of 20-30% would be appropriate. For logs, perhaps 70-
80% of the mensurational volume may be removed. These percentages should be expressed in
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decimal form (eg 45% should be given as 0.45). For lianas, where the product is probably
expressed in length, then the multiplier could be an average length according to the units used
{ft., m). The value entered must be numeric and greater than zero.

Price per unit

This should be the sale price of the unconverted unit at the destination. Prices in IwoPlan are
shown with a $ prefix, although the model has no idea of US§, Guyana § etc. However, all
financial data must be in the same currency units throughout the model. Currencies with high
denominations may cause problems with formatting in some contexts, especially on graphs. For
simplicity and standardisation in international reports, US$ accounting is suggested. The value
entered must be numeric and greater than zero.

Units per standard load

The concept of a standard load is geared towards human or animal-based transport systems,
where products may be hand-carried or carried on pack animals. It is therefore applicable more
to nan-timber products. This multiplier calculates how many units of yield comprise one
standard load. All non-timber product transport costs are stated relative to this load. Timber
could also be extracted in a similar way (fe. manually or by animals) in which case, the scaling
should be much as shown above (ie about 0.03 of a m3 constitutes a 30kg load). Note that this
field is only applied when the transport method (see below) is specified as N; it is ignored
otherwise. The value entered must be numeric and greater than zero.

Transport method

IwoPlan caters for two types of transport cost structures, which are coded in this field by N or L.
N-type transport relates particularly to non-timber products, although it could be applied to
manhandled boards sawn at stump. It uses as the base a concept of a standard load, which needs
to be defined in practice but is probably around 30 kg (ie. what a person can carry any significant
distance or load manually onto a canoe etc.). N-type transport can use trails and rivers in the
transport network.

L-type transport is fully mechanised, and is applicable to logs and timber. It assumes costing on a
per m3 basis, and is restricted to road and forest road networks. If values other than uppercase L
or N are entered, L-type transport is assumed. Note that for management purposes, all L-type
products are treated jointly as being operated on the same coupes, whereas N-type products will
have independently allocated coupes.

Post-harvest survival

When product is removed from a stem, does the stem survive? For timber, the answer is clearly
no (although one might envisage coppicing, perhaps). Therefore, for timber, this factor should be
zero. Harvesting a liana likewise removes the stemn in question. For gums and resins, and leaves,
much depends on how the harvesting is done, but post-harvest survival should be a factor up to
1 (indicating 100% survival). The value entered must be numeric and in the range 0-1.

Harvest damage factor

Removing small non-timber products or lianas does little or no damage to the residual stand.
However, felling large trees clearly does. This factor indicates the proportion of stems in each
diameter class that will be lost after logging as a result of damage, relative to the intensity of
logging. Logging intensity is defined as basal area logged over total stand basal area before
logging. For example, if logging intensity is 15%, and the damage factor is 0.8, then 0.8 x 15%, or
12% of the residual stock of each diameter class will be assumed to be lost as damage. As a rule
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of thumb a damage factor of-about 1 is appropriate. The value entered must be numeric and
greater than zero.

Minimum felling diameter

' Natural forests are typically managed in part by specifying a minimum felling diameter, below
which trees may not be removed. This is specified in IwoPlan on the product table, where the
diameter limit will be applied to all species that produce a given product. The value given must
be numeric, representing a diameter in cm. It may be zero.

Harvesting cycle

The felling or harvesting cycle is a critical control measure to avoid over-exploitation of a plant
resource. In IwoPlan, all T-type' products (ie mechanical logging) is assumed to be done on a
single coupe, so the felling cycle needs only to be specified for one - it will then be applied to all.
For N-type products, each may have its own harvesting cycle. If different L-type products are
given different cycles, IwoPlan will take the longest and apply it to all. A zero value will.indicate
no harvesting, but this will only work for L-type products if all are set to zero. The value entered
must be numeric and a multiple of 5. A value of 5 indicates continuous harvestmg {because the
model works in 5-year steps - see p. 3).

Retained stems

Another conservation or control measure applied to timber, and also appropriate for non-timber
products, is the proportion of stems to be left unharvested. They are specified here as a
percentage, ie 50 means 50% of stems will be left unharvested. The Refained stems can also be
used to indicate a proportion of stems that might be unharvested due to defect or unsuitability,
although above the requ1red size limit. The value entered must be numeric and in the range 0-
100.

Minimum stock

A percentage retention does not protect the future of the stand if stocking is low. This factor
allows a minimum stock to be specified, in terms of stems per km? (ie. 100 x n/ha) above the
diameter limit. If this level is not present, the management unit cannot be harvested. The value
entered must be numeric and zero or above.

Allowable cut

The allowable cut designates the targeted harvesting level. It is a periodic figure, so if IwoPlan is
running with a 5-year time step (as is built-in with version 1.01), the allowable cut is the quantity
per 5 years. It is specified in terms of product units after application of the yield multiplier. For
Hmber units this is m3 of product. IwoPlan will harvest successive management units within a
period until the last one harvested causes the periodic allowable cut to be exceeded. Adjusting
this figure allows scenarios for different scales of operation to be explored. The value entered
must be zero or above. See also the notes on this in Case study I relative to mechanised
harvesting.
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Setup » Transport costs

The Transport costs dialog appears as
opposite as a tabbed box, divided into
three categories: Timber units costs, NTPP
unif costs, and Infrastructure costs. Entries
on the Timber unit costs tab are applied
to products with the L-type Transport

-Harvesting and Uansport costs

method designated on the Products specification form. These would typically be timber extracted
by mechanical logging. Cost factors on the NTPP tab would be applied to products with the N-
type transport method, being typically non-timber products, but possibly also manually extracted
wood products processed at stump. The Infrastructure cost tab applies costs that are linked to
different classes of infrastructure in the map layers. Minor roads are internal forest roads within
MUs. Major roads are the mapped forest road segments linking MUs. Minor bridges are those
crossing rivers with a Bridgeability index of 1. Major bridges are those which cross rivers with a
Bridgeability index of 2. (See the Configuration section for a further explanation of the

bridgeability index).

Setup » Transport network

The Transport network menu item brings up the form
which appears below. The main purpose of this is to check
and regenerate the logical transport network used by the
model. This only needs to be done if either (1) the model is

being installed for the first time, (2) the transport network files appear to be corrupted, or (3) the
processing base is being changed. This form also has on it some software tools for diagnosing
and checking problems with the network. These could arise because of errors in the road or river
system map layers, whereby sections of the network are not properly ]omed up or are

inappropriately classified.

To relocate the processing
base, ensure the option button
labelled Set base point is
checked. Then double click on
the map where the base is to
be located. The map can be
zoomed in or out, or panned
using the feft mouse butfon
{zoom in), right mouse button
(pan), or shift+right mouse bufton
{(zoom out). When the base is
located accurately, click on
the Resef network button to
regenerate the files.

The Reset network button rebuilds three sets of work files used by IwoPlan. These are ~MUlinks,
and the ArcView Shape file sets ~iNef1.* and ~tNet2.*. These are located in the directories set in
the File » Baseline data form. After this has been done, the Transport network form closes. If it is
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re-opened, the diagram shown below will appear, with the processing base (yellow spot) located
appropriately.

If the work files are missing or not in the correct format, then one of several things may result. It
may be impossible to open the Transport network form, with the program giving an execution error
and then closing. Or the form may open with a blank map ares, or the map area will be
complete, but will not show the route and node structures indicated above.

If the form opens, but is either blank or contains a map but lacks route and nodes, simply press
the Resst network button to regenerate the files. If it cannot be opened at all, then the files
~MUlinks, ~tNet1.* and tNet2.* must be entirely deleted. This will allow the form to be opened
normally and the network to be reset (ie. the files will be regenerated correctly).

The most likely causes of these problems are directory changes. Please note that if the
File » Baseline data form is used to change the scenario or geodata directories, the program will
not find the work files, and will behave as indicated.

The Highlight route tool can be used to check that a transport route is fully joined up. Double
clicking on a node will highlight in yellow the shortest route from the node to the base point.

The Blink joined nodes tool shows which nodes are directly linked to any other. Double clicking on
a node causes the joined nodes to flash.

The Blink accessible MUs shows which MUs are directly accessible from any other.

These three tools will rarely be of interest to the normal user. They do demonstrate features of
the transport network logic that are useful in presentations and discussions, but their main
objective is to diagnose faults in program logic and/or GIS files structure. If for example, routes
in a GIS file are not fully joined up, then gaps will occur in the network which can be detected
using these tools.

There are two settings in the Setup » Options form under the Network analysis section that
influence how the transport network is built up. The setting Merge transporf nodes within (m) gives
a tolerance factor to allow for routes that do not properly joinup, A setting of 100 m is
recommended. If a Jow or zero value is used, the GIS input files for roads and rivers must be
processed through the ArcInfo CLEAN function (or its equivalent in other packages) to ensure
that routes are fully joined up.

The Link base to networks within (km) allows a specified processing base to be linked to the transport

network by a spur road, provided it is within the designated distance of a route. If this is zero,
the processing base will be inaccessible unless it is positioned precisely on a route.
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Genesal options

Setup » Options

The Options form includes
several miscellaneous options.
In the Simulation box, the total
time limit for projections can be
set, The /initialize autornatically box
will ensure that the model is

initialised whenever certainkey
settings are changed. Otherwise this process must be done manually before the model is run.
For slower computers, it may be found better to leave this box clear.

The Selection policy frame allows for three ways of allocating management units for harvesting.
The Lowest unit cost option will select the first and subsequent MUs based on the lowest unit cost
of production, taking into account all costs including infrastructure construction and
maintenance. The Highest product density option will select the first and subsequent MUs without
regard to cost, but simply picking those with the highest amounts of product per ha. This is
useful where costs are very uncertain, as high product densities will tend to minimize harvesting
costs. The Least distance fo base option is another option that may be used when costs and price
data are very weak. It will pick management units for harvesting that are closest to the base
point. The Highest product density option will give better results where products are remote but
occur in well aggregated areas, and are not generally ubiquitous. The Least distance option will
be better for more or less uniformly distributed products.

The checkbox marked Aggregate MUs in same period ensures that, if several MUs are to be
harvested in the same period, they will all be adjacent. Otherwise, the model may tend to scatter
them around. The aggregating of MUs may be realistic, especially with the Highest product density
option, but it will be sub-optimal on a pure cost basis, if the Lowest unit cost option is selected.

The Protected areas frame allows specified MU numbers to be listed, and protected from any
harvesting when the Apply checkbox is ticked. When management units are selected for
protection on the Harvest Plan map form, they will automatically be listed here and the Apply
checkbox ticked. That provides a more visual, map-oriented way of protecting units. Units
protected in this way will not be harvested at all. This provides a way of protecting amenity
areas, tourism facilities, and of excluding areas of steep topography, swamp etc.

In the present version of IwoPlan, stream and road buffer zones are not calculated, so the entries
in the buffer zone boxes will be ignored by the program.

The settings in the Network Analysis frame influences how the transport network is constructed
from base map information (roads, and rivers), and is discussed in the Setup » Transport network
section.
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The Run menu, as illustrated at the
right, provides for four functions
relative to starting and stopping
simulations. All of these act directly,
without bringing up intermediate dialog forms.

The Run menu

The Initialise function builds tables of pre-processed information in memory

and resets the resource data to its initial state. This function can be
executed automatically if the Inifiafise automaiically checkbox is ticked on the Setup » Options
menu. For faster computers, it is recommended that this is done. For slower computers, the
initialisation process can take 20-30 seconds and may be tedious if it is invoked unnecessarily, as
for example when changing several product options prior to running the model. For such cases,
manual initialisation via the Run » Initialise menu will be more convenient. It should be noted that
the /nitialise function will close any map windows that are open when it is executed.

When the model requires initialisation, the Reset and Start menus will be grayed out, as will all
the Output sub-menus except for the check map.

The Resef function is similar to Inifialise but faster and more limited. It resets the resource data to
year zero. Whercas /nifiaiise will close any open map windows, Reset allows maps to remain
open, and updates the appearance directly.

The Start menu runs the simulation model until the time limit is reached. Any maps or graphs
open will update interactively whilst this is in process.

The Cance/ menu is normally inactive (shaded gray) but becomes active whilst the simulation is
running, and can be used to cancel a run. The model will stop at the end of the last completed
time period with all maps and displays updated to that point.

3 Chock rua ! s
Outputs » Check Map Foi e TR T

The check map form is used
mainly to verify that the correct
geodata files have been selected.
Clicking on each layer will add it
to the map, and clearing it will
remove it. The order in which the
layers are clicked determines how
they overlay each other. The
figure to the right shows how the
check map form will appear with
the forest type layer displayed
using the demonstration data

b
;
:

3

e

provided. If the check maps do not appear correctly, pIease check that the system is properly
configured (see Map layers and GIS files and File » Baseline data).
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The check map can be zoomed in or out, or panned using the feft mouse button (zoom in), right
mouse button (pan), or shift+right mouse button (zoom out) in the same way as for other maps.

The species distribution map appears as shown below. Initially,
Outputs » Species it will be blank, until at least one species has been selected. To
distribution select species to display, click on the binocular button in the
Species frame. A pop-up list of species will appear, One or
more species can be selected, using standard Windows
methods. Clicking on an item will select or deselect it. Holding
shift and clicking an item will select all species between the first and last one clicked. Holding
Ctrl and clicking can be used to select several species which are not adjacent, or de-select one
species without affecting other selections. When the selection window is closed with the OK
button, then the species chosen will appear listed in the Species frame of the map form. In the
example shown below, a single species, Greenheart, is shown. '

Ap";

e

A

T

The map can show either volume in m?/ha or tree numbers per km?, according to the options
selected in the Parameters frame. The data can also be censored to include only trees above a
specified diameter. The example shows volumes for Greenheart trees of 50 cm and above. The
diameter limits must correspond to those used internally by IwoPlan. It should be noted that the
map does not update immediately when the diameter limit is changed. The map can be updated
by either double-clicking on the diameter field, or by clicking one of the option buttons in the

- Parameters frame.

The Map key shows the colours representing species density, using the units indicated in the
Parameter frame. In the example above, species density is shown in terms of m3/ha> 50 cm
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diameter. The scale normally automatically adjusts
itself each time the map is updated. The Fix scale
checkbox, if ticked, prevents the scale changing
when the map is updated; this is useful when
watching species changes over time as a simulation
progresses, or directly comparing the density of
different species.

The map can be zoomed in or out, or panned using
the feft mouse bution (zoom in), right mouse button
(pan), or shift+right mouse button (zoom out).

The MU numbers checkbog, if ticked, displays the
number of each management unit. This is only
likely to be useful when the map is zoomed in to a fairly large scale, as otherwise the numbers
will be overlaid with each other and unreadable.

The Stand table button will only work when one or more units are selected. Selection can be done
in two ways. Holding the Ctrf key and clicking with the left mouse button will select a single unit.
Holding the Ctrt key and dragging with the right mouse button held down creates a rectangular
area that will select all MUs whose centroids fall within the rectangle. MUs can be de-selected
either by clicking on them individually with the left mouse, or en masse by doing the Cir-Right
mouse button action outside of any designated MUs. Selected MUSs appear in bright yellow, as
shown on a zoomed-in section of the above map.

The stand table bution brings up
a table and histogram for the
selected species and
management units. The
exarnple opposite shows a
histogram of trees per km? by
20-cm diameter classes for
Greenheart. The Opfions tab of
this form allows stem numbers,
basal area or volume to be
tabulated , in normal or

. . ! a4 = SV ) ¢ e ¢ i1 = e
cumulative form, with 10- or 20-  § o ww U ne T e oor
cm diameter classes, per unit ‘ Dixmater elus (em)

area or as area totals. The Table
tab shows the histogram data as a table. Either the table or the histogram can be output to other
packages via the File » Copy menu.
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Quick reference for mouse buiton actions on maps

The various maps produced by Button Action | Effect

IwoFlan all use the same mouse [ "gpy drag | zooms in on the area shown by the drag
button combinations. These are rectangle when the button is released,
summarised in the table at the RIGHT drag | pans the map to folfow the mouse cursor as it is
right. CTRL and SHIFT refer to dragged.

the keyboard keys which should | SHIFT-RIGHT | click zoom out to previous view {position of cursor
be held down prior to clicking does not mater),

the mouse. LEFT and RIGHT are CTRL-LEFT | click selects the management unit under the mouse
mouse buttons. The acton may cursar.

be either a single click (click) ora | CTRL-RIGHT drag se.fecfs gff management units whose centfroids
dragging action, where the fall within dragging rectangle.

mouse button is held down, moved to create a target rectangle on the screen, and then released
{drag).

Note that when management units are selected on one map, they will also appear marked as
selected on another,

The product distribution map appears as shown below. It
Outputs » Product shows the actual products available to harvest based on the
distribution ' Product specifications criteria. In the map below, for

S

e

PR 2 3 ?:%‘;‘:1:5

example, the volumes in m3/ha are shown for Greenheart
trees which are over the minimum diameter of 50 cm, after
deducting an aliowance for a minimum stocking of 200 trees/km?, and an allowance for 50%
retention after harvest, and a 70% conversion factor, as shown in the example on page 9. In other

iicselected areasummary
i Greenheart 1,139,731

M| Other Timber | 634,149/ m3
: 173,005

o

| Less than 4
1408
Btol2
s 121016

t Over 16

RIS R A T
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words, the map shows net extractable quantities of products, respecting ail conservation and management

criteria.

The pull down list in the frame Product shown on map will list all defined products. Selecting one
will update the map to display the distribution of that product.

The table in the frame entitled Sefected area summary lists all the products, and gives either their
quantity per ha, or their total quantity, depending on whether the checkbox Area fofals is ticked or
not. If no management units are selected, this table will include all management units.
Otherwise, it will give totals only for selected units, which appear blue on this map. Units are
selected using the mouse as described in the preceding section.

The scale is always shown in per ha units for the selected product, and normally automatically
adjusts itself each time the map is updated. The Fix scale checkbox, if ticked, prevents the scale
changing when the map is updated; this is useful when watching product availability change
over time as a simulation progresses, or directly comparing the density of different products.

The MU numbers checkbox, if ticked, displays the number of each management unit. This is only
likely to be useful when the map is zoomed in to a fairly large scale, as otherwise the numbers
will be gverlaid with each other and therefore unreadable.

Outputs » Harvest plan

The Harvest Plan map shows the management units which
are harvested for a particular product, coloured according
to the year of operation. The map can also show the

simulated by the model if
the checkbox Show network
is ticked,

If the Exclude selectad MUs
checkbox is ticked, then
any management units
selected with the mouse
will be excluded from
harvesting for any

- product. This is useful for
applying local and
provisional protection
criteria, or for accounting
for topographic barriers
that are not otherwise
represented in the model.
MUSs selected in this way
will appear listed on the

Options form.

notional transport network whose development is

R T am— L
RS

|

R

The map can be zoomed in to examine detail, and at this level, the Show MU numbers checkbox is
useful to identify individual management units,
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The Product yields menu shows a tabbed dialog box, as
Outputs » Product yields shown below, which can display either a graph or a table.
The information given shows the total harvested quantities

harvested {blue line). The

red line is read off theleft y- .
axis, and the blue line of the ¢ :,
N . i -
right axis. ; 25300 :
The general level of i 30000 - '
. . . 9 (] d
production in the model is Bl 2s000 X
: 3
controlled by the Affowable { * 20000 a |k
cut parameter on the 2] B — < B
Product specifications form. | = b
f N i 10000 - n
In this example, it was | - E
25,000 m? per 5-year period. j s00¢ ; ; :
Actual production fluctuates I S — e ———+0
because only whole s sT1wi1s o2 .03 404 01 550 60. g
R ] Time (yeare) ?
management units can be E i
harvested. ? - Greenheart (#3) — Arva(ba) :
; 1,

R R T T T B S e A TR T S T PR T R T e TN

In tabular form, the same data is shown, together with average production per ha, as illustrated
befow.

Production table from the Table tab of the Product Yields form

Period ending (yr) 20 25 i 3] 40 45 50 L13] 60

Area (ha) 2081 2151 2533 2669 2665 2508 29410 1,785 2723

Greenheart (m3) 158,208) 22,982 23485 26,833 26,043 20534| 20,663 11,589| 16,849

Production per ha B.75, 10.68 8.90; 10.08 9.77 8.19 7.03 6.56 6.19

The Cost analysis form allows costs to be viewed in three
Outputs » Costs analysis different ways. For mechanically logged products, the
logging costs view, as illustrated below, shows total cost per
S-year period (in $’000s) and average unit costs (in $/m3 )
for three components of logging: Harvesting (including felling, processing at stump, skidding and
loading), Transportation, and Infrasiructure costs (road and bridge building, road maintenance).
This graph also shows the total cost, or sum of the three components above, and the unit cost, or
total cost divided by total production. This format of graph can also be produced for NTPPs.
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It will be noted on the
graph that the
component costs
(green, blue, red lines)
and total costs (black
line) are read off the
left y-axis. The unit
costs (magenta line)
are read off the right
axis.

FREnE:

?}
E
?
;

CROW wneon

Another possible view
shows total costs for all

4
o

} R e ST o O,

i
products on a single T I é
graph. For this graph, stwhistataslalslalaslsobssen i

. Time (rears) it
separate species of ;
meChanically logged ’ < Harwasting$ == Trasport § == [nfrastrocturs $ == Total cost $ = Tt cost § 5?,.
timber are treated asa  § f

Single item (Iogging BT e T R S T T e e R T T e g A
costs), whereas NTPPs and manually extracted timber will have separate lines for each defined
product.

D5 NI T a0 SRR L W SEAFAND R e

The costs can also be shown as unit costs by products, in another view of the graph selected via
the pull-down menu. The data on the graph can be viewed as a table via the Table tab; this table
can be cut and pasted directly to Excel via the File » Copy function for further analysis or
reformatting.

The Sales & Finance form provides three key graphs that
Output » Sales & Finance represent in many respects the “bottom line” of a project.
These are selected via the pull down menu at the top right
of the form, as shown opposite. The Safes by Products

per S-year period by products. B SR e
The Net safes graph shows the K%@ﬁﬁm '

graph shows the total gross sales
total sales of all products (black ‘

Capitat & IRA

line), the total project costs (red 2000
line) and the net sales (blue line).
¥ 1500
The Table tab shows the figures « 100
from both graphs in tabular / ; 500
format. It has columns for sales % - )
by products, total costs, total sales & o ]
and net sales. This can easily be S
copied to a spreadsheet for 5 00— —— ,
further analysis (see FilexCopy). & S IR N 8 AT s @
) r ‘E Time (years)
The Capital & IRR graph calculates = Tolalsales§ mu Totsleosts$ == Nelsales§
the discounted net worth (DNW)

T o TN T T

of the income stream represented :
by the net sales at interest rates from 0 to 24% in 2% increments. These are plotted as a graph,
and can be used either to indicate the level of investment the project would support (discounted
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to year zero) at any given interest rate, or conversely, to calculate the internal rate of return (IRR)
given a fixed initial investment. This form of the graph is shown below.

1400 - In this example, at 10% interest
0 ‘ 8 pa, the income stream would have
a DNW of around $700,000;
5 1% - B conversely, if $700,000 was the
¥ s0 - j initial investment used to generate
. : the income stream, the IRR would
D 600 - be 10%.
o 400

200

ol 2" a4l 6l gl 1201 141 16" 18 20 221 24
Ininrest rate %

The Window menu has no sub-menus, but rather shows a

The Window menu pull-down list of open forms. Selecting one of these forms

will make it active. This is useful mainly where one form is
hidden
under another, and cannot be activated by
directly clicking onit. The image at the right
shows how the menu appears with four forms
open. The currently active form will be ticked.

n 1 18
Tlmbae

Fanr:] r.\!ati pp o

It is important to note that if more than one
map form is open at a time, the model will not be able to run simulations over time. Only one
map form should therefore be open when running the simulator.

Help ropms.muﬂmu Help/ "

M.JW&M eﬁ,_.
The Help menu . mhgz 5

The Help menu brings up the online
Help system’s contents Window, as
shown opposite. Clicking on the
relevant details brings up appropriate
help.

m] Coneepts and technical features
@ Geoprocessing methods
@ Transport nelwork analysis
Harvest allocation
Financial analysis
Farest growth models

The most useful section is the menu
system page, which allows help to be
located via the menu bars. All the
available help pages are listed under
the List of Help pages, whilst conceptual
and background information is given
under the Concepis and technical features

(3 Using the model

@ The menu system
Q]] List of help pages
The main menu
@ The Fila menu
The Setup menu
@ The Uutpuis menu

entry.
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Gonfiguration

To install IwoPlan on a computer, the operating system
must be Microsoft Windows NT, 98, 2000 or XP. The
hardware must comprise af least a 400 Mhz processor, with

First-time installation of 64 MB of RAM and 30 MB of free hard disk space. If used

twoPlan on a machine of lower specification, it may run excessively
slowly and be difficult to use. On networks, IwoPlan must
be instailed on the local workstation, or on a private
network directory?.

Installation files can be downloaded from the internet. There are two files which must be
downloaded:

O http://www.bio-met.co.uk/iwoplan/install zip (10.1 MB)
0 hitp://www.bio-met.co.uk/iwoplan/scenarios.zip (0.9 MB)

It is recommended that a file is created called C:\IWOPLAN on the local hard disk of the target
computer. If another directory is used, then the name must be substituted in the instructions
which follow where C:\ IWOPLAN is referred to. Note that during installation, if using a secure
version of Windows (eg. Windows NT), the user must have privileges to add files to the system
directories and amend registry keys.

Download the two files noted above into C:\IWOPLAN; or if you are using the CD version of the
installation kit, copy them from the CD. Unpack them using a WinZip-compatible utility
ensuring that the Include original path option is ticked. This should create the following sub-
directories, each containing various files:

a C\IWOPLAN\INSTALL
O C\IWOPLAN\SCENARIOS

‘o C:\ IWOPLAN\ SCENARIOS\ GEODATA

In the ..\INSTALL directory will be
found a file called SETUP.EXE. This
should be executed, It will bring up
an installation Wizard. Follow this
through its default button options
until the screen shown at the right is
reached. Then use the Change
Directory button to locate and set
C:\IWOFLAN (or your chosen
alternative) as the installation
directory. Click on the installation

button {(computer icon) to complete
the process.

1 If installed in a shared (public) network directory, the program may lock up or crash if used by two users
sinultaneously.
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Once installation is completed, the files in the directory ..\ INSTALL ate no longer required for
operation and can be deleted or archived elsewhere if disk space is critical. Similarly, the original
*.zip files can be removed. This will save about 22MB.

The program will be found as an entry under the Windows Starf » Programs menu, and can be
executed from there. It can also be executed by the Windows Explorer, for example, by clicking
on the file C:\ IWOPLAN\ IWOPLAN.EXE.

At this stage, if the suggested default directory C:\IWOPLAN\ has been used, then the program
can be used directly to work through the various examples given in the Case studies section. If a
different directory has been used, then refer to the further configuration instructions given in the
following sections before trying to use the program.

When IwoPlan is updated, only the file IWOPLAN.EXE in the
installation directory C:\IWOPLAN needs to be replaced.
The latest version of IWOPLAN.EXE can be downloaded from
the web directly by entering the URL on the Internet
browser:

Updating an installed version

http:/ / www.bio-met.co.uk/iwoplan/iwoplan.exe

When the browser asks if the file is to be run or saved to disk, it should be saved to C:\IWOPLAN,
thereby overwriting the earlier copy.

No other action is necessary when updating IwoPlan. When the updated version is loaded, the
version number will be seen on the title bar.

IwoPlan requires four sets of ArcView-compatible shape

files, representing map layers for rivers, roads, management
Map layers and GIS files units, and forest types. An additional layer is optional, but

is recommended. This represents the project boundary.

The installation kit includes demonstration versions of
these files, which are early versions of studies on Iwokrama forest. Each shape file set comprises
at least the following three files: *.shp (the map vector information), *.shx (the geoindex file),

*.dbf (the map attribute table). Additionally, *.sbn and *.sbx files may be seen. These latter are
work files and do not need to be present initially.

If one of the required map layer file sets or components is missing, or is in a directory that is not
recognised, then IwoPlan will not work properly. Faults of this kind can be detected using the
File » Check map menu, before attempting to run any other Setup or Oufput menu function.

Setting the map layer directory, file names and attribute fields

The directory containing the map layers, if the recommended default installation is followed, will
be C:\IWOPLAN\ SCENARIOS\ GEODATA. However, the map layers may be in any directory,
provided that all the required layers are in the same one, The map layers directory is set via the
File » Baseline data menu, which brings up the dialog box shown below right. Clicking on the
open file button in the Directory for map fayers frame will allow the directory containing the map
layer files to be located. Double-click on any shape file within the required directory to set it as
the map layers directory. Note that the directory cannot be correctly set by directly typing into
the text box (the field is not editable).
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When the directory is changed, all the

entries in the Shape file names frame
will become blank: Each type of shape
file and its associated key field must be

re-set, as described in more detail in
the following sections. Once this has
been done, the form may be closed
and the settings saved by clicking the
OK button. If the form is closed via the
Cancef button, by Ctrl-F4, or by the X
button on the top right of the form
window, the settings will not be saved.

The Management Units layer

In the default mstallatlon, the management units layer is represented by the files MU19.SHP,
MU19.DBF and MU19.5HX. This file set can be replaced by another file containing map information
about management units. The following criteria should be observed when developing an MU
map layer:

@ The management units should be of as nearly equal size as practicable. Very large
management units should be split, and small ones merged to achieve this.

Q For good results in simulated projections, there should be at least 100 MUs per project. The
demonstration file contains about 400 MUs.

O Itis important to note that the shape file must have polygon topology.

O Management units which are bisected by larger rivers or streams are undesirable; waterways
should be used if possible as natural boundaries. Otherwise, infrastructure costs will be
under-estimated by the model, as it will not recognise the need for bridges where rivers
bisect a single MU

Only one management unit attribute (je. field in the *.dbf file) is required by IwoPlan. That is the
management unit identification number (abbreviated to MUID). The MUID must be a number
(numeric field) and should not exceed 32767 in value.

The MU shape file is set on the Baseline data form by selecting the appropriate shape file from the
management units pull down in the Shape file names frame. The MUID field is then selected by
picking the appropriate attribute field for management unit IDs in the key fields frame.

The Forest Types layer

The forest types map layer in the default installation is given by the file set FORTYP_REVISED.*.
This file can be replaced by another file representing forest types. The forest types must be
represented by polygons (ie. have polygon topology). The attribute (*.dbf) file should contain a field
with the forest type code. This can be any alphanumeric code, but it must the same as the code
used in the stand table file, which describes the forest types in terms of species and stocking,

The forest type shape file is set on the Baseline data form by selecting the required file name from
the forest types pull down in the Shape file names frame. The appropriate attribute field for forest
type codes is then selected in the key fields frame.
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Streams and Rivers

In the demonstration data set, the rivers and
streams are described in the HYD10.5HP shape
file. This file can be replaced by another file
representing hydrology. This map layer must
have linear topology (ie. it should not contain
lakes or large rives represented by polygons).
Two important attributes need to be set for
each segment of river or stream. These are the
navigabifity index and the bridgeability index.
These values must be integers. For
navigability, they may be between 0 and 2, and
for bridgeability, from 0 to 3. The table below
indicates appropriate values for these indices.

In the demonstration file (HYD10.5HP) these
indices have been estimated in relation to
stream order (ie. number of branches above the
Essequibo River main stream). More

Attribute fields required for Rivers &
Streams map layer

Navigahility index

0 | Not accessible and navigable for product extraction

1 | Accessible and navigable to small boats for
transport of NTPPs and manually loaded boards.

2 | Accessible and navigable to large boats for
transport of logs and crane-loaded timber (eg.
capacity at least 5 tons), or navigable by log-rafts.

Bridgeability index

0 [ Can be bridged by culverts, with cost subsumed
into normal road construction cost.

1 | Can be bridged by single span log bridge (eg. max
20 m), with cost defined as minor bridge on
infrastrugture costs form.

2 | Requires2+ spans, with average cost given by
major bridge on infrastructure costs form.

3 | Not bridgeable within the context of normal forest
road construction,

realistically, they need to be estimated from river width and presence of cataracts, or direct

surveys of more significant waterways.

The rivers and streams shape file is set on the Baseline data form by selecting the appropriate
shape file from the Rivers & streams pull down in the Shape file names frame. The appropriate
attribute fields for navigability and bridgeabilify are then selected in the key fields frame.

Roads

In the demonstration data set, the road system is described in the RD_SEG.SHP shape file. This file
can be replaced by another file representing a road system. This map layer must have linear
topology. This file does not need any attributes. The roads mapped should be permanent roads
that are constructed and maintained with funds that are outside the project costing (eg. public
roads). The shape file is set via the Permanent roads pull down in the Shape file names frame.

Project border

The project border or boundary layer is optional, and could be omitted. It appears as a
background on the Species, Products and FHarvest maps, with areas inside the border but not

covered by any management unit being shown

in a background shade of pink (species map) or

green (products, harvest maps). If the layer is missing, these areas will simply be blank. The
topology of this layer may be either linear or polygon. The shape file is set via the Border pull

down in the Shape file names frame.

Steps in sefting up new map fayers

After the shape file names and key fields have been set on the Baseline data form, it must be
closed with the OK button to save the information. If doing this for the first time with new map
layers that have not yet been checked, the IwoPlan program should at this point be closed and re-
started. This is important as it will force the settings to be written to disk in the default scenario
file. Otherwise, if the program crashes while testing the files, the settings have to be re-entered,

which is somewhat tedious.
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After re-starting IwoPlan, go first to the File » Check map menu and review each layer in turn.
Various problems could occur. If the files are in the wrong format, or a member of the shape file
set is missing, or the files are in the wrong directory, the program may crash after a rather
uninformative message such as “ Valid object expected as argument”. If this occurs, revert to the
Baseline data form and ensure the correct directories are used and correct layer and field names
given.

If this does not resolve the problem, test each layer again in ArcView, and ensure that they can
be viewed correctly from the IwoPlan geodata directory, as given on the Basefine data form.

Once the files can be viewed in the Check map, and there are no scaling or overlay discrepancies
due to incompatible GIS coordinates, then the intermediate files used by IwoPlan need to be set
up by following the procedure in the Setup » Transport network section.

The stand table file sttab.iwd will be found in the default
Forest inventory and the scenarios directory C:\IWOPLAN\SCENARIOS after
stand table file completing the standard installation process. This file gives
a description of each forest type in terms of species and
stem numbers by size classes. Part of the file is listed in the
text box below. This comma-separated file format can be imported into or saved from Microsoft
Excel, or saved from a database file using the comma-separated option.

ForType,Code, Species, N/km2,0-9,10-19,20~-29,30-3%, 40-45,50-59,60~69,70~79,80-89,90-59,100+, ,
DF,101,Greenheart, 695, ,40,30,40,238,188,59,50,40,10,,,
DF,108,Muri,20,,,,10,,,,10,,,,,

DF,188,akama, 1546,,178,178,149,436,317,168,40,50,20,10,,
DF,202,Wallaba,1387,,50,188,178,446,287,158,50,20,10,,,
DF,304,Bulletwood,30,,,10,,,20,,,,,/:

b¥,306,White cedar,60,,,20,,20,20,,,:¢/:

DF,307,Crabwood, 158,,,20,69,59,,10,,,,++
DE,308,0al1i,10,,,,+10, 0 00vr s
DF,312,Kabukalli,st,,,,,,10,20,10,10,,,,

DF,316,Mora, 368,,10,30,40,99,59,40,20,30C,30,10,,
DF,318,Freijol,10,,,,10,,,rvr+r+s
bF,326,Wamara,3%7,,30,50,50,158,59,20,20,10,,,,
DF,338,Purpleheart,10,,,vsv00..320,,,

DF, 440, Aromata, 70, ,20,20,,20,30,,,,.+,

The first line of the file are headings, which are useful if the data is imported into Excel, but are
ignored by IwoPlan.

The second and subsequent lines consist of a forest type code, a species code, a species names,
and then stem numbers per km? by diameter classes. The diameter classes, as indicated by the
heading line, comprise 0-9 cm, 10-19 cm, ete, up te 90-99 cm, then 100 cm and above.

The forest type code must correspond to the codes in the forest type code attribute field of the
forest type map layer.

The species codes must link to the species list, which is defined in the Setup » Species list table.
This species list is physically stored within a scenario file, whose format and contents are
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described in the next section, and can be manually edited there. It should be noted that the
species codes must be integer numbers less than 32768.

It would be very difficult to create the stand table file directly with a text editor. The normal
routes to creating the stand table file would be via a forest inventory program which can create
files in a suitable format in Excel. The Excel tables are then saved as comma-separated files (CSV)
with a structure as above. Both the MYRLIN and GEMFORM programs can generate tables in a
suitable format from a variety of inventory plot designs. MYRLIN is documented at and
available from http://www.myrlin.org. GEMFORM is available from http:/ /www.bio-

met.co.uk/gemform.

It should be noted that the species name field in the STTAB.IWD file is not the name used by
IwoPlan, That is given by the name in the species list corresponding to the linked species code.
The name in the above file is for reference purposes only, and could in principle differ from the
name in the species list.

The default scenario file is called DEFAULT.IWP, and must be

present in the directory named in the Directory for scenario
The default scenario file and resource files frame of the Baseline data form. This file is
a text file, and can be viewed and edited with a standard
text editor, Itis supplied with the standard installation, but
may need to be modified manually if a new species list or different growth models are adopted.
The species list and growth models can be modified from the relevant setup menus (see Setup »
Species list and Setup » Growth models), but this can be very slow if there are many changes to
be made.

The default scenario file is always saved whenever IwoPlan is closed, using all current settings
under the various Sefup menus. It is therefore important, if making changes that may modify the
scenario file in a major way, to save the earlier version manually before making the changes. This
can be done via the File » save scenario menu,

The scenario file consists of various sections, each headed by a title in square brackets, such as
{Basoline], [Species], [Tree models], etc. These sections could appear in any order. Following each
section are a series of entries in the style key=value(s). It may be noted that in the [Basefing] and
[Options] sections, the key names correspond to global variable names within IwoPlan,

The species list section

[8pecies]
The first part of the species list 1=Bamboo, Guadua angustifolia, Grass, A
section appears as shown 2=Rupununi Grass, Trachypogon plumosus, Grass, A

X o 7=Nibbi, Heteropsis spp., Liana, A, CN
opposite, Itis introduced by the §=Kufa, Clusia spp., Lizna, A, CN

section code [Specjesj_ The 10=Manicole, Euterpe spp., Palm, A

. . 20=Ite, Mauritia flexuosa, Palm, A
species code is followed by an 30=Karia, Astrocaryum sciophilum, Palm, A

equals sign, then the common S0=Arapipi, Astrocaryum vulgare, Palm, A
name, botanical name, life form 60=Kokerite, Attalea maripa, Palm, A
. 70=Buba, Socrotea exorrhiza, Palm, A
(grass, liana, palm or tree}, 80=Turu, Oenocarpus bataua, Palm, A
growth model letter, and 101=Greenheart, Chlorocardium rodiei, Tree, M, GH
. 108=Muri, Humiria balsamifera, Tree, E
gggmsnany’ one or more product 120=SandpaperTree, Curatella americana, Tree, E
es.

This list can be created
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programmatically if it is very long, as for example from a database file, and then edited into the
DEFAULT.IWP file using a text editor. The codes on the left of the = sign must correspond to the

species codes in the stand table file STTAB.IWD.

The growth models section

The growth models may be in several sections,
headed by [Tree models].[Liana models], [Palm
models] or [Grass models], these being the four
life forms currently recognised by IwoPlan.
Each section may define a number of models,
with one line per model. The model code,
which must be a single capital letter, is to the
left of the equals sign. To the right are the four
parameters of each model. For tree models,
these are diameter increment, mortality rate,
95% diameter percentile, and the form height
coefficient for volume calculation, The source
and rationale of the growth models are
discussed in the Concepts section. As with the

{Tree models]

A=
B=
C=
D=
E=
F=
G=
H=
Jg=
K=
L=
M=
=
E=

134,
.252,
.359,
222,
.36,

.518,
686,
.983,
.198,
.524,
.34,

.218,
.561,
527,

.0l48,
.018,
L0339,
L0175,
L0687,
L0204,
L0225,
L6322,
L0157,
.0187,
0072,
.posz,
L0187,
.0091,

32.%,
37.9,
29.6,
43.9,
50.3,
42.3,
54.3,
55,
54.2,
63.5,
69.7,
7L1.1,
93.4,
78.1,

11.2,
12.5,
0.6,
12.6,
12.1,
11.9,
12.6,
10.86,
13.6,
13,
13.86,
13,
12.5,
13.8,

0,

o,

0,
0'

D'

0,

ol

o,
0,

Gl

9,

o,

a,
¢,

0

Q

0
0

species list, the list of growth models will usually be derived from some other spreadsheet

analysis, and it will probably be found to be more convenient to cut and paste it directly into the

default scenario file than to edit the Growth model form.
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